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DESCRIPTION

LTC6810-1
Daisy Chain isoSPI 

Battery-Stack Monitor

Demonstration circuit 2515A is a multicell battery-
stack monitor featuring the LTC®6810-1, a 6 channel 
battery-stack monitor. Multiple boards can be linked 
through a 2-wire isolated serial interface (isoSPI) to 
monitor a long series of cells in a stack. The demo cir-
cuit also features reversible isoSPI enabling a redundant 
communication path.

The DC2515 can communicate to a PC by connecting 
directly to a DC2026 Linduino® One. The DC2026 must be 
loaded with the appropriate program (called a “sketch”) All registered trademarks and trademarks are the property of their respective owners.

PERFORMANCE SUMMARY

to control the battery stack monitor IC and receive data 
through a USB serial port. The DC2026C provides a stan-
dard SPI interface which can be connected directly to a 
DC2515 board (J4 Connector). Or, the SPI can be trans-
lated to isoSPI and then connected to a DC2515 isoSPI 
port (J2/J1 connector). The DC1941 provides a single 
SPI-isoSPI channel, and the DC2792 provides two SPI-
isoSPI channels for reversible operation.

Design files for this circuit board are available.

Specifications are at TA = 25°C

PARAMETER MIN TYP MAX UNITS

V+ Supply Voltage 5.0 20 27.5 V

V+ to C6 Voltage –0.3 V

C0/S0 Voltage 0 5 V

VREG Supply Voltage 4.5 5 5.5 V

VREF1 1st Reference Voltage, No Load 3.1 3.2 3.3 V

VREF2 2nd Reference Voltage, 5k Load to V– 2.994 3 3.006 V

VBIAS IBIAS Voltage, READY/ACTIVE State 1.9 2.0 2.1 V

CPIN Input Range 0 5 V

Cell Count 6

https://www.analog.com/DC2515A?doc=DC2515A.pdf
http://www.analog.com
http://www.analog.com
https://www.analog.com/LTC6810-1?doc=DC2515A.pdf
https://www.analog.com/en/design-center/evaluation-hardware-and-software/evaluation-boards-kits/DC2515A.html#eb-documentation?doc=DC2515A.pdf
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HARDWARE SETUP
Wiring J3 Connector

The DC2515A demo circuit (board) connector pinout is 
critical; correct wiring must be followed to avoid the risk 
of damaging the demo board.

When connected to a battery stack, power for the DC2515 
is provided by the cell group being monitored. To connect 
the cell group, separate the screw-terminal block section 
from the J3 connector. Then, insert the cell-voltage con-
nections or resistors into the screw-terminal clamping 
contacts. These connections provide the power and input 
stimulus for the battery stack monitor IC.

Cell-voltages are wired to J3 starting from position 4 
(most negative potential of the group). Please refer-
ence the appropriate demo board J3 connector pinout 
in Table 1.

Alternatively, resistors can be used to simulate battery 
cell-voltages. 100Ω 0.5W or equivalent resistors are rec-
ommended because 100Ω (or lower values) typically will 
not induce measurement errors and the 0.5W (or greater 
rating) will keep the resistor temperatures low preventing 
power dissipation damage.

DC2515A 6 Resistor Connection

Carefully connect six 100Ω resistors onto the screw-
terminal block between each CPIN input clamping con-
tact from position 4 to position 10 as shown in Table 1, 
DC2515A J3 Pinout and Figure 1, Resistor Divider String. 
Provide a stack-equivalent power supply connection to 
position 10 (positive) and position 4 (negative). The 
power supply may be adjusted to provide the desired 
nominal cell-voltage (ex. 19.8V will be 3.3V per cell).

Table 1. J3 Pinout
J3 Pin CPIN Input

1 NC

2 NC

3 V–

4 C0/V–

5 C1

6 C2

7 C3

8 C4

9 C5

10 C6

11 NC

12 NC

13 NC

14 NC

15 NC

16 NC

Figure 1. 

100Ω

DC2026 F01

Resistor Divider String

https://www.analog.com/DC2515A?doc=DC2515A.pdf
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JUMPERS

USING OTHER SPI MASTER BOARDS

DC2515 SERIAL INTERFACE OPTIONS

The on-board jumpers must be set to match the desired 
mode of operation. These jumpers can enable the Dis-
charge Timer and select the serial communication mode 
of the battery stack monitor IC.

ISOMD Jumpers JP1, JP2, and JP4

0:	Set jumpers to 0 for standard SPI communication to 
the IC through the J4 connector.

1:	Set jumpers to 1 for isoSPI communication to the IC 
through either the J1 or J2 connector.

DTEN Jumper JP3

0:	Set jumpers to 0 for Discharge Timer disable.

1:	Set jumpers to 1 for Discharge Timer enable.

The DC2515 has several communication options. The 
DC2026 Linduino One provides a USB-to-SPI interface, 
and is ideal to interface from a PC to any SPI device. In 
this case, the DC2026 SPI interface can connect directly 
to the DC2515 (see section entitled DC2026 to DC2515 
SPI Connection for details). Alternately, the DC2026 SPI 
can be translated to isoSPI via the DC1941 (single isoSPI 

channel) or DC2792 (dual isoSPI channels) demo boards. 
The DC2792 dual master isoSPI demo board can be con-
nected as a typical single-ended isoSPI bus master or to 
both ends of a reversible configuration with two isoSPI 
bus masters. The DC1941 can be connected as a typical 
single-ended isoSPI bus master.

When a different SPI Master microcontroller board is used 
instead of the DC2026, more components or equipment 
are required to properly interface to the demo boards. 
Here are the requirements:

SPI MISO Line

Most SPI Master microcontroller boards will not have a 
SPI MISO line pull-up. A 5kΩ pull-up resistor is required 
on the SPI MISO line because the battery stack monitor 
IC SDO is an open drain NMOS output pin. Otherwise, 
the SPI MISO line will be floating where the SPI readback 
of each byte will typically appear as no response or all 

one’s or 0xFF’s. There are several places where the pull-up 
resistor can be installed. On the microcontroller board, a 
5kΩ resistor can be added between the microcontroller 
SPI MISO line and the microcontroller VCC pin.

isoSPI IC Power

A separate 5V power supply is required when using a 
different SPI Master microcontroller board. The DC2026 
J1 header provides power for the isoSPI IC through the 
14-pin ribbon cable into the DC2792 J1 header or the 
DC1941 J2 header. Refer to demo manual DC2792A 
or demo manual DC1941D for external power supply 
instructions.

https://www.analog.com/DC2515A?doc=DC2515A.pdf
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DC2026 TO DC2515 SPI CONNECTION
A SPI connection begins with the SPI Master connected to 
the first (or “bottom”) DC2515. Additional DC2515 boards 
can be daisy-chained onto the isoSPI bus. Communication 
begins from the first (or “bottom”) DC2515 then to the 
next “upper” DC2515 and, finally, to the last (or “top”) 
DC2515.

Figure 2 shows the following connections for two boards 
on a stack interfaced to a PC:

1.	Connect a USB cable from the PC USB port to the 
DC2026 J5 connector.

2.	Connect the DC2026 to the DC2515 in SPI mode. This 
DC2515 is the first (or “bottom”) board of the stack.

a.	Connect a 14-pin ribbon cable from the DC2026 J1 
header to the “bottom” DC2515 J4 header.

b.	Set JP1, JP2, and JP4 to 0 for SPI communication.

c.	JP3 can be 0 or 1 depending if the Discharge Timer 
function is being used.

3.	Connect or daisy-chain the DC2515 to another 
DC2515 in isoSPI mode. This DC2515 is the last 
(or “top”) board of a two-board stack. More DC2515 
“upper” boards can be daisy-chained together in the 
same manner.

a.	Connect a RJ45 patch cable from the “bot-
tom” DC2515 J1 isoSPI B RJ45 connector to the 
next “upper” or “top” DC2515 J2 isoSPI A RJ45 
connector.

b.	Set the next “upper” or “top” DC2515 JP1, JP2, and 
JP4 to 1 for isoSPI communication.

4.	CAUTION! Prevent damage to the DC2515. Refer to 
Table 1 and confirm that the cell-voltage connections to 
the screw-terminal block matches the DC2515 J3 pinout.

a.	Plug the screw-terminal blocks into the J3 cell-
voltage connectors.

5.	Refer to the Software Setup section of this demo manual 
to properly setup the PC with the Arduino IDE software 
to allow communication to the DC2515 boards.

Figure 2. DC2026 SPI Connection to the “Bottom” DC2515 in a Two-Board DC2515 Stack
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https://www.analog.com/DC2515A?doc=DC2515A.pdf
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DC2792 TO DC2515 TYPICAL isoSPI CONNECTION
A typical isoSPI connection begins with the isoSPI Master 
connected to the first (or “bottom”) DC2515. Additional 
DC2515 boards can be daisy-chained onto the isoSPI 
bus. Communication begins from the first (or “bottom”) 
DC2515 then to the next “upper” DC2515 and, finally, to 
the last (or “top”) DC2515.

Figure 3 shows the following connections for two boards 
on a stack interfaced to a PC:

1.	Connect a USB cable from the PC USB port to the 
DC2026 J5 connector.

2.	Connect the DC2026 to the DC2792 Dual Master isoSPI 
demo board.

a.	Connect a 14-pin ribbon cable from the DC2026 J1 
header to the DC2792 J1 header.

3.	Connect the DC2792 to the DC2515 in isoSPI mode. 
This DC2515 is the first (or “bottom”) board of the 
stack.

a.	Connect a RJ45 patch cable from the DC2792 J2 
MAIN RJ45 connector to the “bottom” DC2515 J2 
isoSPI A RJ45 connector.

b.	Set the “bottom” DC2515 JP1, JP2, and JP4 to 1 
for isoSPI communication.

c.	JP3 can be 0 or 1 depending if the Discharge Timer 
function is being used.

4.	Connect or daisy-chain the DC2515 to another DC2515 
in isoSPI mode. This DC2515 is the last (or “top”) board 
of a two-board stack. More DC2515 “upper” boards can 
be daisy-chained together in the same manner.

a.	Connect a RJ45 patch cable from the “bot-
tom” DC2515 J1 isoSPI B RJ45 connector to the 
next “upper” or “top” DC2515 J2 isoSPI A RJ45 
connector.

b.	Set the next “upper” or “top” DC2515 JP1, JP2, and 
JP4 to 1 for isoSPI communication.

5.	CAUTION! Prevent damage to the DC2515. Refer to 
Table 1 and confirm that the cell-voltage connections to 
the screw-terminal block matches the DC2515 J3 pinout.

a.	Plug the screw-terminal blocks into the J3 cell-
voltage connectors.

6.	Refer to the Software Setup section of this demo manual 
to properly setup the PC with the Arduino IDE software 
to allow communication to the DC2515 boards.

Figure 3. DC2792 Typical isoSPI Connection to the “Bottom” DC2515 in a Two-Board DC2515 Stack
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DC2792 TO DC2515 REVERSE isoSPI CONNECTION
A reverse isoSPI connection begins with the isoSPI 
Master connected to the last (or “top”) DC2515. Additional 
DC2515 boards can be daisy-chained onto the isoSPI bus. 
Communication begins from the last (or “top”) DC2515 
then to the next “lower” DC2515 and, finally, to the first 
(or “bottom”) DC2515.

Figure 4 shows the following connections for two boards 
on a stack interfaced to a PC:

1.	Connect a USB cable from the PC USB port to the 
DC2026 J5 connector.

2.	Connect the DC2026 to the DC2792 Dual Master isoSPI 
demo board.

a.	Connect a 14-pin ribbon cable from the DC2026 J1 
header to the DC2792 J1 header.

3.	Connect the DC2792 to the DC2515 in isoSPI mode. 
This DC2515 is the last (or “top”) board of a two-board 
stack.

a.	Connect a RJ45 patch cable from the DC2792 J2 
MAIN RJ45 connector to the “top” DC2515 J1 iso-
SPI B RJ45 connector.

b.	Set the “top” DC2515 JP1, JP2, and JP4 to 1 for 
isoSPI communication.

c.	JP3 can be 0 or 1 depending if the Discharge Timer 
function is being used.

4.	Connect or daisy-chain the DC2515 to another DC2515 
in isoSPI mode. This DC2515 is the first (or “bottom”) 
board of a two-board stack. More DC2515 “lower” 
boards can be daisy-chained together in the same 
manner.

a.	Connect a RJ45 patch cable from the “top” DC2515 
J2 isoSPI A RJ45 connector to the next “lower” or 
“bottom” DC2515 J1 isoSPI B RJ45 connector.

b.	Set the next “lower” or “bottom” DC2515 JP1, JP2, 
and JP4 to 1 for isoSPI communication.

5.	CAUTION! Prevent damage to the DC2515. Refer to 
Table 1 and confirm that the cell-voltage connections to 
the screw-terminal block matches the DC2515 J3 pinout.

a.	Plug the screw-terminal blocks into the J3 cell-
voltage connectors.

6.	Refer to the Software Setup section of this demo manual 
to properly setup the PC with the Arduino IDE software 
to allow communication to the DC2515 boards.

Figure 4. DC2792 Reverse isoSPI Connection to the “Top” DC2515 in a Two-Board DC2515 Stack
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DC2792 TO DC2515 REDUNDANT isoSPI CONNECTION
A redundant isoSPI connection begins with the primary 
(or “main”) isoSPI Master connected to the first (or 
“bottom”) DC2515 and has a backup auxiliary (or “aux”) 
isoSPI Master connected to the last (or “top”) DC2515. 
Additional DC2515 boards can be daisy-chained between 
the two isoSPI masters on the isoSPI bus. Primary (or 
“main”) communication begins from the first (or “bot-
tom”) DC2515 then to the next “upper” DC2515 and, 
finally, to the last (or “top”) DC2515. The backup auxiliary 
(or “aux”) communication begins in the reverse direction 
to provide coverage when a possible isoSPI daisy-chain 
break occurs.

Figure 5 shows the following connections for two boards 
on a stack interfaced to a PC:

1.	Connect a USB cable from the PC USB port to the 
DC2026 J5 connector.

2.	Connect the DC2026 to the DC2792 Dual Master isoSPI 
demo board.

a.	Connect a 14-pin ribbon cable from the DC2026 J1 
header to the DC2792 J1 header.

3.	Connect the DC2792 primary (or “main”) isoSPI master 
to the first (or “bottom”) DC2515 board of the stack.

a.	Connect a RJ45 patch cable from the DC2792 J2 
MAIN RJ45 connector to the “bottom” DC2515 J2 
isoSPI A RJ45 connector.

b.	Set the “bottom” DC2515 JP1, JP2, and JP4 to 1 
for isoSPI communication.

c.	JP3 can be 0 or 1 depending if the Discharge Timer 
function is being used.

4.	Connect or daisy-chain the DC2515 to another DC2515 
in isoSPI mode. This DC2515 is the last (or “top”) board 
of a two-board stack. More DC2515 “upper” boards can 
be daisy-chained together in the same manner.

a.	Connect a RJ45 patch cable from the “bot-
tom” DC2515 J1 isoSPI B RJ45 connector to the 
next “upper” or “top” DC2515 J2 isoSPI A RJ45 
connector.

b.	Set the next “upper” or “top” DC2515 JP1, JP2, and 
JP4 to 1 for isoSPI communication.

5.	Connect the DC2792 auxiliary (or “aux”) isoSPI Master 
to the last (or “top”) DC2515 board of the stack.

a.	Connect a RJ45 patch cable from the DC2792 J3 
AUX RJ45 connector to the “top” DC2515 J1 isoSPI 
B RJ45 connector.

6.	CAUTION! Prevent damage to the DC2515. Refer to 
Table 1 and confirm that the cell-voltage connections to 
the screw-terminal block matches the DC2515 J3 pinout.

a.	Plug the screw-terminal blocks into the J3 cell-
voltage connectors.

7.	Refer to the Software Setup section of this demo manual 
to properly setup the PC with the Arduino IDE software 
to allow communication to the DC2515 boards.

Figure 5. DC2792 Redundant isoSPI Connections to the “Bottom” and “Top” DC2515 in a Two-Board DC2515 Stack
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DC1941 isoSPI MASTER SETTINGS
The DC1941 jumpers must first be properly set to inter-
face between DC2026 and DC2515.

Refer to demo manual DC1941D for jumper setting details.

Figure 6 shows the proper board settings.

1.	JP2: VCC = DC590.

2.	JP3: ENABLE = EN.

3.	JP4: SLOW = 0.

4.	JP5: MODE = MASTER.

5.	JP6: VCCS = VCC.

6.	JP7: PHA = 1.

7.	JP8: POL = 1.

8.	JP9, JP10: VTH = VTH2.

Figure 6. DC1941 isoSPI Master Mode Jumper Settings
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DC1941 TO DC2515 TYPICAL isoSPI CONNECTION
A typical isoSPI connection begins with the isoSPI master 
connected to the first (or “bottom”) DC2515. Additional 
DC2515 boards can be daisy-chained onto the isoSPI 
bus. Communication begins from the first (or “bottom”) 
DC2515 then to the next “upper” DC2515 and, finally, to 
the last (or “top”) DC2515.

Figure 7 shows the following connections for two boards 
on a stack interfaced to a PC:

1.	Connect a USB cable from the PC USB port to the 
DC2026 J5 connector.

2.	Connect the DC2026 to the DC1941 isoSPI demo board.

a.	Connect a 14-pin ribbon cable from the DC2026 J1 
header to the DC1941 J2 header.

3.	Refer to the DC1941 isoSPI Master Settings section of 
this demo manual to properly setup the DC1941.

4.	Connect the DC1941 to the DC2515 in isoSPI mode. 
This DC2515 is the first (or “bottom”) board of the 
stack.

a.	Connect a RJ45 patch cable from the DC1941 J1 
RJ45 connector to the “bottom” DC2515 J2 isoSPI 
A RJ45 connector.

b.	Set the “bottom” DC2515 JP1, JP2, and JP4 to 1 
for isoSPI communication.

c.	JP3 can be 0 or 1 depending if the Discharge Timer 
function is being used.

5.	Connect or daisy-chain the DC2515 to another DC2515 
in isoSPI mode. This DC2515 is the last (or “top”) board 
of a two-board stack. More DC2515 “upper” boards can 
be daisy-chained together in the same manner.

a.	Connect a RJ45 patch cable from the “bot-
tom” DC2515 J1 isoSPI B RJ45 connector to the 
next “upper” or “top” DC2515 J2 isoSPI A RJ45 
connector.

b.	Set the next “upper” or “top” DC2515 JP1, JP2, and 
JP4 to 1 for isoSPI communication.

6.	CAUTION! Prevent damage to the DC2515. Refer to 
Table 1 and confirm that the cell-voltage connections to 
the screw-terminal block matches the DC2515 J3 pinout.

a.	Plug the screw-terminal blocks into the J3 cell-
voltage connectors.

7.	Refer to the Software Setup section of this demo manual 
to properly setup the PC with the Arduino IDE software 
to allow communication to the DC2515 boards.

Figure 7. DC1941 Typical isoSPI Connection to the “Bottom” DC2515 in a Two-Board DC2515 Stack
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DC1941 TO DC2515 REVERSE isoSPI CONNECTION
A reverse isoSPI connection begins with the isoSPI mas-
ter connected to the last (or “top”) DC2515. Additional 
DC2515 boards can be daisy-chained onto the isoSPI bus. 
Communication begins from the last (or “top”) DC2515 
then to the next “lower” DC2515 and, finally, to the first 
(or “bottom”) DC2515.

Figure 8 shows the following connections for two boards 
on a stack interfaced to a PC:

1.	Connect a USB cable from the PC USB port to the 
DC2026 J5 connector.

2.	Connect the DC2026 to the DC1941 isoSPI demo board.

a.	Connect a 14-pin ribbon cable from the DC2026 J1 
header to the DC1941 J2 header.

3.	Refer to the DC1941 isoSPI Master Settings section of 
this demo manual to properly setup the DC1941.

4.	Connect the DC1941 to the DC2515 in isoSPI mode. 
This DC2515 is the last (or “top”) board of a two-board 
stack.

a.	Connect a RJ45 patch cable from the DC1941 J1 
RJ45 connector to the “top” DC2515 J1 isoSPI B 
RJ45 connector.

b.	Set the “top” DC2515 JP1, JP2, and JP4 to 1 for 
isoSPI communication.

c.	JP3 can be 0 or 1 depending if the Discharge Timer 
function is being used.

5.	Connect or daisy-chain the DC2515 to another DC2515 
in isoSPI mode. This DC2515 is the first (or “bottom”) 
board of a two-board stack. More DC2515 “lower” 
boards can be daisy-chained together in the same 
manner.

a.	Connect a RJ45 patch cable from the “top” DC2515 
J2 isoSPI A RJ45 connector to the next “lower” or 
“bottom” DC2515 J1 isoSPI B RJ45 connector.

b.	Set the next “lower” or “bottom” DC2515 JP1, JP2, 
and JP4 to 1 for isoSPI communication.

6.	CAUTION! Prevent damage to the DC2515. Refer to 
Table 1 and confirm that the cell-voltage connections to 
the screw-terminal block matches the DC2515 J3 pinout.

a.	Plug the screw-terminal blocks into the J3 cell-
voltage connectors.

7.	Refer to the Software Setup section of this demo manual 
to properly setup the PC with the Arduino IDE software 
to allow communication to the DC2515 boards.

Figure 8. DC1941 Reverse isoSPI Connection to the “Top” DC2515 in a Two-Board DC2515 Stack
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SOFTWARE SETUP
The DC2515 can be controlled by the DC2026 Linduino One board. The DC2026 is part of the Arduino compatible 
Linduino platform that provides example code that will demonstrate how to control the multicell battery stack monitor 
ICs. Compared to most Arduino compatible microcontroller boards, the DC2026 offers conveniences such as an iso-
lated USB connection to the PC, built-in SPI MISO line pull-up to properly interface with the battery stack monitor IC 
open drain SDO, and an easy ribbon cable connection for SPI communication through the DC2515 14-pin QuikEval™ 
J4 connector.

Arduino IDE Setup

1.	Download then install the Arduino IDE onto the PC. Detailed instructions can be found at www.analog.com/en/
design-center/evaluation-hardware-and-software/linduino.html under the quick start tab.

2.	Set the Arduino IDE to open BMS Sketchbooks. From within the Arduino IDE, click on File menu select Preferences. 
Then under Sketchbook location: select Browse, and locate the path to the extracted bmsSketchbookBeta.zip file 
that was provided by ADI.

	

3.	Close then re-open the Arduino IDE to enable the use of the Sketchbook Location that was previously set.

https://www.analog.com/DC2515A?doc=DC2515A.pdf
http://www.analog.com/en/design-center/evaluation-hardware-and-software/linduino.html
http://www.analog.com/en/design-center/evaluation-hardware-and-software/linduino.html
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SOFTWARE SETUP
4.	Select the correct COM port to allow communication to DC2026 through USB. Under the Tools menu, select Port → 

Select the highest number COMxx with the “” check mark symbol. There may be more than one option; DC2026 is 
usually the highest COM port number. The PC screenshots used in this example show the DC2026 connected to COM6.

	

5.	Select the correct Arduino compatible microcontroller board. Under the Tools menu, select Board → Arduino/
Genuino Uno with the “” black dot symbol.

	

6.	Open one of the programs or “sketches” associated with the DC2515. In this example LTC6810-1 sketch will be 
opened. Under the File menu, select Sketchbook → Part Number → 6810 → DC2515_New.

	

https://www.analog.com/DC2515A?doc=DC2515A.pdf
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SOFTWARE SETUP
7.	Upload the DC2515_New sketch onto the DC2026 by clicking on the Upload button on the top left corner. When 

this process is completed there will be a “Done uploading” message on the bottom left corner.

	

8.	Open the Arduino Serial Monitor tool. Click on the Serial Monitor button on the top right corner then the Serial 
Monitor window will open and show on the top left corner the COMxx used.

	

9.	Configure the Serial Monitor to allow communication to the DC2026 through USB. On the bottom of the Serial 
Monitor window, set the following starting from bottom left to bottom right:

a.	Click on the Autoscroll checkbox for the “” check mark symbol.

b.	Select Both NL & CR on the left dropdown menu.

c.	Select 115200 baud on the right dropdown menu.

d.	As shown below, when configured correctly the DC2515_New sketch menu will appear.

		

https://www.analog.com/DC2515A?doc=DC2515A.pdf
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APPENDIX A: THE SKETCHBOOK CONTENTS
The bmsSketchbook will generally contain the follow-
ing folders: Libraries, Part Number, Documentation, 
and Utilities.

Libraries directory: contains a subdirectory for each IC 
in the sketchbook. Each subdirectory contains a .cpp and 
.h file. These files contain all of the constant definitions 
and low-level IC command implementations. Porting to 
a different microcontroller requires changes to some 
library files.

Part Number directory: contains example control pro-
grams for each IC. Inside the Part Number folder, each 
BMS IC has a sketch(.ino) file that implements a control 
program to evaluate the functionality of the IC. This sketch 
allows the user to control the IC through a serial terminal 
and make all primary measurements. This sketch also 
allows for evaluation of self-test and discharge features 
of the IC. Generally, the name of a sketch relates to the 
IC’s demo board. For example, the sketch for LTC6804 
is DC1942.ino, for LTC6811 it is DC2259.ino, and for 
LTC6810 it is DC2515_New.ino.

Utilities directory: contains support programs, including 
a program that emulates a standard Linear Technology 
DC590 isolated USB to serial controller.

Documentation directory: contains html documentation 
for the provided code base. Documentation for all of the 
BMS ICs can be accessed by opening the Linduino.html 
file, as found in the main sketchbook directory (shown 
below) and in the Documentation directory.

What Is A Sketch

A “sketch” is simply another word for a microcontroller/
Linduino program. The term is generally only used when 
referring to Arduino based programs, as sketches have 
several abstractions that remove some of the complex-
ity of a standard microcontroller(MCU) program. All 
sketches contains two primary functions, the setup() and 
the loop() function. These are in fact the only functions 
that are mandatory in a sketch and are almost always 
implemented in some form in a typical MCU program. The 
setup() function is run once at power on or after the MCU 
is reset. The setup() function generally is used to initial-
ize the MCU peripheral circuits and to initialize all of the 
control variables. The loop() function is similar to a main() 
function that has implemented an infinite loop inside a 
standard C program. The code within the loop() function 
is typically where the primary program code is placed. 
The code within the loop() function will repeat infinitely.

Sketch Modifications

Sketches can be modified to a set of applications spe-
cific requirements. All sketches are written such that the 
most common modifications can be made by changing 
the variables listed in the /*Setup Variables */ table at the 
top of the sketch. For reference, example modifications 
to a DC2259 (LTC6811) sketch are shown below. These 
modifications are applicable to most of the available BMS 
ICs in the sketchbook.

https://www.analog.com/DC2515A?doc=DC2515A.pdf
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Common modifications can be made by changing the 
Setup Variables. The most common application changes 
are listed below. After the variables are changed, the 
sketch will need to be recompiled and uploaded to the 
Linduino.

1.	To change the number of ICs in the isoSPI network, 
change the TOTAL_IC variable. A number between 1 
and 4 should be entered. In an application that has 2 
devices in the network the modified line will look like:
const uint8_t TOTAL_IC = 2;

2.	Often an application may need to sample data at a rate 
faster than the default 500ms (2Hz). To modify the loop/
sample rate the MEASUREMENT_LOOP_TIME variable 
should be changed. The loop time must be entered in 
milliseconds and should be a number larger than 20mS. 
To change the loop rate to roughly 10 measurements 
a second the loop rate should be changed to 100mS. 
The modified line will look like:
const uint16_t MEASUREMENT_LOOP_TIME = 100;

3.	It is possible to modify which measurements fall within 
the loop during the Loop Measurements command. The 
following list are the measurements that can be looped:
const uint8_t MEASURE_CELL = ENABLED;
// This is ENABLED or DISABLED
const uint8_t MEASURE_AUX = DISABLED;
// This is ENABLED or DISABLED
const uint8_t MEASURE_STAT = DISABLED;
//This is ENABLED or DISABLED

	 By default only a cell measurement is done, as noted by 
MEASURE_CELL = ENABLED. What measurements are 
made can be changed by setting what the Measure field 
is equal to. To Measure Cells and the Status register 
but not the AUX register, the variables would be setup 
as shown below:
const uint8_t MEASURE_CELL = ENABLED;
// This is ENABLED or DISABLED
const uint8_t MEASURE_AUX = DISABLED;
// This is ENABLED or DISABLED
const uint8_t MEASURE_STAT = ENABLED;
//This is ENABLED or DISABLED

4.	ADC conversion settings can also be modified in the 
Setup Variables section. The default setup is to run the 
ADC in ‘Normal’ mode, which has a 7kHz filter code; 
in this mode the ADC_OPT bit is Disabled. Typical 
choice for which cell to convert is ALL. Full ADC 
conversion programming requires setting ADC_OPT, 
ADC_CONVERSION_MODE, CELL_CH_TO_CONVERT, 
AUX_CH_TO_CONVERT, and STAT_CH_TO_CONVERT. 
These variables are programmed with constants listed 
in the LTC68xy_daisy.h file. For simplicity they are also 
listed below:
MD_422HZ_1KHZ
MD_27KHZ_14KHZ
MD_7KHZ_3KHZ
MD_26HZ_2KHZ
ADC_OPT_ENABLED
ADC_OPT_DISABLED
CELL_CH_ALL
CELL_CH_1and7
CELL_CH_2and8
CELL_CH_3and9
CELL_CH_4and10
CELL_CH_5and11
CELL_CH_6and12

	 To set the ADC to have a 1kHz filter corner the ADC_OPT 
and ADC_CONVERSION_MODE variables would be 
changed to:
ADC_OPT = ADC_OPT_ENABLED;
ADC_CONVERSION_MODE = MD_422HZ_1KHZ;

	 To convert only cells 2 and 8,
CELL_CH_TO_CONVERT = CELL_CH_2and8;

5.	In another example, the user may wish to change the 
undervoltage and overvoltage thresholds. Each number 
is based on an LSB of 100 µV.
//Under Voltage and Over Voltage Thresholds
const uint16_t OV_THRESHOLD = 41000;
// Over voltage threshold ADC Code. LSB = 0.0001
const uint16_t UV_THRESHOLD = 30000;
// Under voltage threshold ADC Code. LSB = 0.0001

https://www.analog.com/DC2515A?doc=DC2515A.pdf
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ESD Caution 
ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection 
circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality.

Legal Terms and Conditions
By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and 
conditions set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation 
Board until you have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement. This Agreement is made by and between you (“Customer”) 
and Analog Devices, Inc. (“ADI”), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to 
Customer a free, limited, personal, temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and 
agrees that the Evaluation Board is provided for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted 
is expressly made subject to the following additional limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third 
Party to access the Evaluation Board. As used herein, the term “Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is 
NOT sold to Customer; all rights not expressly granted herein, including ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all 
be considered the confidential and proprietary information of ADI. Customer may not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of 
use of the Evaluation Board or termination of this Agreement, Customer agrees to promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile 
or reverse engineer chips on the Evaluation Board. Customer shall inform ADI of any occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited 
to soldering or any other activity that affects the material content of the Evaluation Board. Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS 
Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written notice to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF 
LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI MAKES NO WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY 
DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, EXPRESS OR IMPLIED, RELATED TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT OF INTELLECTUAL PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS 
LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES RESULTING FROM CUSTOMER’S POSSESSION OR USE OF THE EVALUATION BOARD, INCLUDING 
BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI’S TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE AMOUNT OF ONE 
HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the Evaluation Board to another country, and that it will comply with all applicable United States 
federal laws and regulations relating to exports. GOVERNING LAW. This Agreement shall be governed by and construed in accordance with the substantive laws of the Commonwealth of Massachusetts 
(excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts having jurisdiction in Suffolk County, Massachusetts, and Customer hereby submits 
to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement and is expressly disclaimed.

https://www.analog.com/DC2515A?doc=DC2515A.pdf
https://www.analog.com
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